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1 Introduction

1.1 Overview

Sky Analyzer for ASTERIX is a powerful tool to open, decode, analyze and inspect surveillance data in
Eurocontrol All Purpose STructured Eurocontrol SuRveillance Information EXchange (ASTERIX) for-
mat.
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Data Item 1062/080 TRACK_STS:MULTI I0€2/010 | Data Source Identifier 02 SAC:001 SIC:001
Data Item 1062/200 T:UND L:UND V:LEVEL 1062/015 | Service Identification 01 | svc_1p:ooo
Data ltem 1062/136 LEVEL:30000 LSB:FT : :
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~ Data Record 3
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Figure 1.1: Sky Analyzer for ASTERIX

Sky Analyzer for ASTERIX allows you not only read ASTERIX data, but also make further analyzer on

it.

It can also work with other tools, and give you a full capability from data recording, inspection, ana-
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lyzing to modification, generation and simulation.

1.2 Features

1.2.1 Categories

The ASTERIX format defines different category for different type of surveillance.

Sky Analyzer for ASTERIX supports all commonly used ASTERIX categories, and different versions of
some category. It will continue expand its capability to support more categories in future.

The supported categories and versions are:

Category Title Version
CATO01 Monoradar Target Reports 1.0
CATO002 Monoradar Service Messages 1.0
CAT004 Safety Net Messages 1.1
CAT008 Transmission of Monoradar Derived Weather Information 1.0
CATO010 Transmission of Monosensor Surface Movement Data 11
CATO015 Independent Non-Cooperative Surveillance System Target 1.1
Reports
CATO016 Independent Non-Cooperative Surveillance System 1.0
Configuration Reports
CAT019 Multilateration System Status Messages 1.2
CAT020 MLT Messages 1.7,1.8
CAT021 ADS-B Messages 0.23,0.26,2.1
CAT023 CNS/ATM Ground Station and Service Status Reports 1.2
CAT034 Transmission of Monoradar Service Messages 1.27
CATO048 Transmission of Monoradar Target Reports 1.15
CAT062 SDPS Track Messages 1.7

SinoATC Ltd. 2
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Note: Most categories are backward compatible, which means if the version of your data is lower
or equal to the version listed in the table above, it can be correctly decoded.

CATO021 is one exception of this backward compatibility.

1.2.2 User Application Profile

The ASTERIX standard defines all possible data items, but the existence and order of these data items
are defined by User Application Profile (UAP).

Sky Analyzer for ASTERIX supports all standard UAP, and some widely used property UAPs defined by
major ATC system vendors.

The supported UAPs are:

« Standard UAP
 Proprietary UAP of Raytheon radar
« Proprietary UAP of Thales ADS-B

Further more, Sky Analyzer for ASTERIX is able to analyze the data and automatically select a proper
UAP to decode it. Normally user don’t need to worry about UAP selection.

1.2.3 File Formats

Sky Analyzer for ASTERIX supports a various of different file formats, including both open and property
format. It can read and analyze data from all supported file format, there is also one File Convertor tool
to make conversion between these formats.

The supported file formats are:

+ XML Recording File (.rex)

« Compressed XML Recording File (.rez, .rex.xz)
+ Binary Recording File Version 2 (.reb)

+ Recording Index File (.rei)

« tcpdump/Wireshark Capture File (.pcap)
« Raw ASTERIX Data Stream (.ast .bin)

+ Indra ATM System Recording File

+ Thales ATM System Recording File

+ SIATM ATM System Log File

+ AirNet ATM System Log File

+ Indra Radar Recording File

SinoATC Ltd. 3
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Note: Some formats listed above may not appear in your application, it depends on your license
type.

Note: Some more proprietary formats are not listed here and supported only in customized/OEM

version. Please contact us if you are interested in supporting proprietary file format.

1.2.4 Comm-B Data Selector

Sky Analyzer for ASTERIX is capable to decode Comm-B Data Selector (BDS) data embeded in some
data items. It is useful as some important data (e.g. FMS selected altitude) is not defined by ASTERIX
and the only way to retrieve it is from BDS.

The supported BDS are:

« BDS 1,0 - Data Link Capability Report

« BDS 2,0 - Aircraft Identification

« BDS 3,0 - TCAS/ACAS Active Resolution Advisory
+ BDS 4,0 - Selected Vertical Intention

« BDS 5,0 - Track and Turn Report

« BDS 6,0 - Heading and Speed Report

1.2.5 Data Inspection

Sky Analyzer for ASTERIX has friendly HMI and allows you read, decode and inspect data.

It supports different types of data sources, including

+ Recording file
» LAN
« Synchronous serial line

And it supports different types of data frame, including

« Raw data without frame
« HDLC

« UDP

« Proprietary frame type

And there are two views to visually display data

+ Message view, to display data frame/block/record/item in a tree structure

SinoATC Ltd. 4
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« Target list view, to display data record in a table structure

Also there is a powerful scriptable function allows you find and show only data you are interested.

1.2.6 Data Analyze

Apart from viewing the data, Sky Analyzer for ASTERIX has a set of tools to make further analyze on
surveillance data.

+ Radar north marker & sector missing Analyze tool, allows you to analyze the continuity of radar
rotation reports;

« Radar coverage analyze tool, allows you to generate radar coverage map by using real history
data;

+ ADS-B receiver coverage analyze tool, allows you to generate ADS-B receiver coverage map for
a single ground station by using real history data;

« ADS-B network coverage analyze tool, allows you to generate ADS-B coverage map for a ADS-B
ground station network by using real history data;

+ Message transmission delay analyze tool, allows you to detect transmission delay problem.

1.2.7 Data Export

Data and analyze result can be exported into different formats, including

o C/C++struct
Microsoft Excel CSV
Google Earth KML
HTML

Adobe PDF

1.2.8 Support Tools

There is also a set of tools to expand the capability of Sky Analyzer for ASTERIX, including

« File Convertor, to make conversion between different data file formats;

Sky Recorder, a generic purpose tool to record and replay data;

Sky Playback, a multi channel data playback tool, specially designed to reply ASTERIX data;
Sky Simulator, an ASTERIX data simulation tool;
« Sky Converter, a radar front-end processor tool to filter, modify and convert live radar data;

Sky Display, an ATC surveillance data display terminal.

SinoATC Ltd. 5
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Note: Some of above tools are not free and need to be purchased separately.

1.3 Document Structure

This manual is divided into several chapters.

Part 1. Data Inspection

Introduction
Getting Started
User Interface
« Filter

Part 2. Data Manipulation

+ File Converter
+ Export to Google Earth KML

Part 3. Data Analyze

+ Radar Coverage Analyze
+ Radar North Marker & Sector Missing Analyze
+ Message Transmission Delay Analyze

Part 4. Appendix

« Changelog

1.4 Copyrights

Sky Analyzer for ASTERIX is a product of SinoATC Ltd., please contact info@sinoatc.com for more
information.

SinoATC Ltd. 6
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2 Getting Started

2.1 User Interface

Sky Analyzer for ASTERIX has a modern and easy to use user interface. The main window composes
of menu bar, tool bars, status bar and main view.

All functions can be accessed through main menu, and major functions can be accessed through tool

Title bar = [m} X
e View Ane ool Hele  Menu bar
Ltk @IQDBEEE B 0 G
PY®QO.P. L ids8dad 16 OB m B8 G
Open Close Capture  Message List  Fiter lua Clear  Frame  UAP TL FEs & D0 0 BF G (b Gy G &F Oty Ehaan Gp G0 -7
aintootbar
Timestamp Size Dataitem Summary 0000 3e 04 fS bf 5d a6 01 01 00 04 3c 80 00 64 51 00
1 2016-01-0101:00:00000 16 ~ Data Block 1 0010 01 €= 51 20 06 74 d4 £8 93 2b 01 be fc af 0% 43 |
v Data Record 1 0020 ef 07 £1 4c 71 cO 19 28 a0 73 d3 Oc a0 7a df 01
2 2016-01-0101:00:00458 44 Data ftem 1062/010 SAC:001 SIC:001 0030 dz 05 c8 05 c2 00 24 00 00 00 00 00 00 éd 60 03
3 2016-01-0101:00:00408 44 Data ltem [062/015 SVC_ID:000 0040 2= 00 00 01 00 00 €3 Ob 76 Ol 11 01 4e £0 05 cS c.v...
oy 0050 00 00 Sf a8 4a 4a 41 33 34 30 32 80 42 37 33 38 . JJA3402.B738
200+ Data Item 1062/070 TOD:00:36:09.000 =
4 2016-01-0101:00:00.698 16 D:t: It:: IOZWS WGSEA 95 E0INT2BAEE0E 0060 4d 52 4b 53 49 50 47 53 de 00 00 01 0a 17 2d 80 | MRKSIEGSN..... -
-01-01 01:00+ - 0070
3 |206-01-01 010000722 36 Data ltem 1062/100 X:211562.0 V:-243306.0 LB || 0o 0
6 2016-01-0101:00:00.000 80 Data Item 1062/185 VX:111.50 V:-212.00 LSBM/ |00
7 2016-01-01 01:00:00458 68 gm:ta"‘:ggg g"uggﬁﬂ)’?f;g 0020 bE
ata ltem : 00b0 00 €3 54 00 01 6d 96 60 05 a2 ce fd 8f 21 03 89
& 2016-01-0101:00:00.498 20
Data ltem 1062/040 TRACK NUM:2934 00c0 00 7b 00 48 01 01 0l Se fc 0l £0 00 00 bf 4d a4
9 2016-01-0101:00:00.608 20 Data ltem 1062/080 TRACK_STS:MULT!
10 2016-01-01 01:00:00.000 42 Data ltem 1062/200 T:UND LUND V:LEVEL Data Record - 1062
11 |2016-01-01 01:0000453| 20 Data ltem 1062/136 LEVEL:37025 LSB:FT
-01-01 01:00:00- Data Item 1062/220 VH:0.00 LSE:FT/MIN Raw Data in Hexadecimal
12 2016-01-0101:00:00498 33 Data Item 1062/390 SUBFIELDS:08/14
13 2016-01-01 01:00:00.698 40 v D‘“EDR:‘IC;“’ 2|0w"';'17)";;\’;50‘3’1 scoon Ootet 1 Octet 16
ata ltem : :
w seororoman b o5 ARRRRRREARHARMARRE
15 2016-01-0101:00:00.458 59 Data Item 1062/070 TOD:00:36:09.000
Data ltem 1062/105 WG584:361637TN1285728F 40 | 7B | BO (5D | 82 | 08 | 20 |82 | 08 |20 00 00|00 |C3 |01 | 01
16 2016-01-D101:00:00498 64
Data ltem 1062/100 X:224468.0'Y:-130855.0 LSB:M 01 |4E | FO (04 |BO |00 |00 | —[—|—|—|—|—|—|—]--
17 2016-01-0101:00:00.698 64 Data ltem 1062/185 VX:-153.50 V¥:103.25 LSB:M/:
18 2016-01-01 01:00:00.000 1273 Data ltem 1062/060 MODE_3/A:3257 List of Dataitems
Data ltem 1062/320 SUBFIELDS:03/28
Data Item 1062/040 TRACK_NUM:0195
Data Item 1062/080 TRACK_STS:MULTI I0€2/010 | Data Source Identifier 02 SAC:001 SIC:001
Data Item 1062/200 T:UND L:UND V:LEVEL I0€2/015 | Service Identification 01 | svc_ip:ooo
EE:E ::Em :ggﬁg tﬂ"gﬁﬂgﬂgﬁfi‘m I062/070 | Time of Track Information 03 | Top:00:36:03.000
~ Data ;:{Dr:m} o i I0€2/105 | Calculated Position in WGESE4 C s WGSE84:3€1€3TN1285728E
Data ttem 1062/010 SAC:001 SIC:001 I0€2/100 | Calculated Track Position (Cartesian) 0e X:2244€8.0 Y:-130855.0 LSB:M
Data ltem 1062/015 SVC_ID:000 I0€2/185 | Calculated Track Velocicty (Cartesian) 04 VE:-153.50 V¥:103.25 LSB:M/S
Data ltem [062/070 TOD:00:26:09.000 I0€2/060 | Track Mode 3/A Code 02 | MODE_3/A:3257
Data ftem 1062/105 WGS84:364438N1283137E I0€2/380 | Rircraft Derived Data 15 | SUBFIELDS:03/28
Data Item 1062/100 X:184679.0 Y:-79983.0 LSB:M 0627040 | Track Number PP I ———
Data Item 1062/185 VX:226.25 VV:30.75 LSB:M/S e
Data ltem 1062/040 TRACK_NUM:0072 I0€2/080 | Track Status 04 TRACK STS:MULTI
Status bar

Figure 2.1: Main Window

Detailed information of user interface can be accessed at chapter “User Interface”.
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2.2 ASTERIX Step by Step

A typical way of using Sky Analyzer for ASTERIX is to open and analyze data in recorded file. Below is
an example to show how to do it step by step.

2.2.1 STEP 1. Prepare file with ASTERIX data

Sky Analyzer for ASTERIX supports different file formats.
You can use the Sky Recorder tool to record and generate recording files.
You can also use common tools like Wireshark or tcpdump to generate recording tiles.

Here, assuming we already have a data file named “radar.rex”.

2.2.2 STEP 2. Open and load file

Launch the Sky Analyzer for ASTERIX application, select File -> Open File..., a standard Open File Dialog
will appear.

Browse and select our data file “radar.rex”.

In the left panel in main window, many data packets contained in the data file will be shown. A se-
guence number, time stamp, and size of data packet will be displayed.

In the title bar, the file name will be displayed.

SinoATC Ltd. 8
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4 radar.rex - ASTERIX Protocol Analyzer — [m] ®

Fle View Analyze Tool Help

DQONN .. QQ@0SG0 @ PO O & 6 00 p

File Mcast Stop  Tree Track Frame UAP XML C/C++ €SV KML HTML PDF  Coverage North Delay Conv Record Playback Simulator Help Exit

Filter | ~| ¥ Lua o Apply X Clear

Timestamp Size Dataitem Summary

12479 2017-04-10 11:14:25.740 16
12480 2017-04-10 11:14:25.828 64
12481 2017-04-10 11:14:25.853 50
12482 2017-04-10 11:14:25.885 72

12483 2017-04-10 11:14:25.913 64
12484 2017-04-10 11:14:25.964 16
12485 2017-04-10 11:14:26.087 16
12486 2017-04-10 11:14:26.210 16
12487 2017-04-10 11:14:26.336 16
12488 2017-04-10 11:14:26.460 16
12489 2017-04-10 11:14:26.583 16
12490 2017-04-10 11:14:26.707 16
12491 2017-04-10 11:14:26.832 16
12492 2017-04-10 11:14:26.926 16
12493 2017-04-10 11:14:26.975 64
12494 2017-04-10 11:14:27.080 16
12495 2017-04-10 11:14:27.168 16
12496 2017-04-10 11:14:27.222 64
12497 2017-04-10 11:14:27.329 16
12498 2017-04-10 11:14:27.452 16
12499 2017-04-10 11:14:27.575 16

12500 2017-04-10 11:14:27.584 16

Figure 2.2: File Loaded

If you don’t need to load all packets contained in the data file, you can select File -> Stop Processing to
stop the file loading process at any time.

2.2.3 STEP 3. Decode data

If the data packet contained in data file use default frame type (no frame) and default UAP (ASTERIX
standard UAP), you can simply select one data packet, and the data block/record/item will be shown
in the middle panel. Also the radar data of this packet will be shown in hex format in the top-right
panel.

SinoATC Ltd. 9
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4 radar.rex - ASTERIX Protacol Analyzer - o x
Fle View Analyze Tool Help

ODQONN .0 Q@000 @ POO0E = 6 OO p

File Mcast Stop  Tree Track Frame UAP XML C/C++ €SV KML HTML PDF  Coverage North Delay Conv Record Playback Simulator Help Exit

Filter | ~] @ lua o Apply X Clear
Timestamp Size " || Dataitem Summary 0000 30 00 3b £f £7 02 46 £9 4f 08 ca a8 70 18 £9 23
R et ~ Data Block 1 0010 24 c4 05 2c e0 22 03 bd 78 06 93 Oc 22 bS5 cf 8d
12479 2017-04-10 11:14:25.740 16 0020 20 02 c0 a8 00 31 58 00 00 40 c4 Za 2Zb 30 el Oc
~ Data Record 1
0030 01 &0 00 04 07 bf 80 4c 46 20 f£6 37 e7 bS 00 00
12480 2017-04-10 11:14:25.828 64 Data ltem 1048/010 SAC:070 SIC:249
12481 | 2017-04-10 11:14:25.853| 56 Data ltem 1048/140 TOD:11:14:25.578

Data Item 1048/020 TYPE:ROLL CALL CHN2
Data Item 1048/040 RHO:112.1 THETA:350.3
12483 2017-04-10 11:14:25.913 64 Data Item 1048/070 MODE_3/A:2304 SMOOTHED
12484 2017-04-10 11:14:25.964 16 Data ltem 1048/090 MODE _C:0331
Data ltem 1048/130 SUBFIELDS:03/07
Data Item 1048/220 ADDR:780693
12486 2017-04-10 11:14:26.210 16 Data ltem 1048/240 ACID:CBI5384
12487 2017-04-10 11:14:26.336 16 Data ltem 1048/250 BDS:4,0 6,0
12488 2017-04-10 11:14:26.460 16 Data ltem [048/161 TRACK_ NUMD004

Data Item 1048/200 SPD:435.72 HDG:180.42
12489 2017-04-10 11:14:26.583 16 Data ltem 1048/170 TYPE:SSR
12490 2017-04-10 11:14:26.707 16 Data ltem 1048/230 FS:AIR

12482 2017-04-10 11:14:25.885 72

12485 2017-04-10 11:14:26.087 16

12491 2017-04-10 11:14:26.832 16
12492 2017-04-10 11:14:26.926 16
12493 2017-04-10 11:14:26.975 64
12494 2017-04-10 11:14:27.080 16
12495 2017-04-10 11:14:27.168 16
12496 2017-04-10 11:14:27.222 64
12497 2017-04-10 11:14:27.329 16
12498 2017-04-10 11:14:27.452 16
12499 2017-04-10 11:14:27.575 16

12500 2017-04-10 11:14:27.584 16

Figure 2.3: Select Data Packet

If you select any data record or dataitem in middle panel, the detail of this data record/item will shown
in the bottom-right panel.

Also please note the data of selected data record/item will be highlighted.

SinoATC Ltd. 10
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4 radar.rex - ASTERIX Protacol Analyzer - o x
Fle View Analyze Tool Help

ODGONN .0 Q@000 @ P00 L = 6 0O p

File Mcast Stop  Tree Track Frame UAP XML C/C++ €SV KML HTML PDF  Coverage North Delay Conv Record Playback Simulator Help Exit

Filter | ~| ¥ Lua o Apply X Clear

Timestamp Size " || Dataitem Summary 0000 30 00 3b ££f £7 o2fELFE] 4f 08 ca a8 70 18 £9 23 | O.:
T e ——— ~ Data Block 1 0010 24 c4 05 2c &0 22 03 bd 78 06 93 Oc 22 b5 cf 8d | §.
12479 2017-04-10 11:14:25.740 16 0020 20 02 c0 a8 00 31 58 00 00 40 c4 2a 2b 30 e0 Oc

~ Data Record 1
0030 01 60 00 04 07 bEf 80 4c 46 20 £6 37 e7 bS 00 Q0

12480 2017-04-10 11:14:25.828 64 Data Item 1048/010 SAC:070 SIC:248
12481 2017-04-10 11:14:25.853 56 Data ltem 1048/140 TOD:11:14:25.578

Data Item 1048/020 TYPE:ROLL_CALL CHN2
Data Item 1048/040 RHO:112.1 THETA:330.3

12482 2017-04-10 11:14:25.885 72

12483 20170410 11:1425.913| 64 Data ltem 1048/070 MODE 3/:2304 SMOOTHED || Data Item 1048/010 - Data Source Identifier
12484 2017-04-10 11:14:25.964 16 Data ltem 1048/090 MODE _C:0331
Data ltem 1048/130 SUBFIELDS:03/07 s
-04-10 11:14: ummar
12485 2017 0410 111426087 | 16 Data ltem 1048/220 ADDR:780693 v
12486 2017-04-10 11:14:26.210 16 Data ltem 1048/240 ACID:CBJ5384 SAC:07051C:249
12487 2017-04-10 11:14:26.336 16 Data Item 1048/250 BDS:4,0 6,0
O e T Data ltem 1048/161 TRACK_NUM:0004 Raw Data in Hexadecimal
Data ltem 1048/200 SPD:435.72 HDG:180.42
12489 2017-04-10 11:14:26.583 16 Data Item 1048/170 TYPE:SSR et Bl =i o
12490 2017-04-10 11:14:26.707 16 Data ltem 1048/230 FS:AIR P [ [ [ [ R I IO IV N R

12491 2017-04-10 11:14:26.832 16

12492 2017-04-10 11:14:26.926 16 Raw Data in Binary

12493 2017-04-10 11:14:26.975 64 Oores 1 - 42 Ootet 2 - F3 detet 3 - -- deet 4 -
12494 2017-04-10 11:14:27.080 16 oltlolololzlz]ola]alalalelalalal-]-|-[<]-]-]-[-[-T-[-]-]-
12495 2017-04-10 11:14:27.168 16
12496 2017-04-10 11114:27.222 64 Detaild Description

12497 2017-04-10 11:14:27.329 16 System Area Code (SAC)

12498 2017-04-10 11:14:27.452 16 | | ‘ | ‘

12499 2017-04-10 11:14:27.575 16

|oeterz] [sac [ oxee [ 070 |2 | Marehell Islends L) |
12500 2017-04-10 11:14:27.584 16 o, « v

Figure 2.4: Select Data Item

Onthe other hand, if data packet is not in default frame type and UAP, it can not be correctlly decoded
before you select correct one.

You can select View -> Frame to select frame type, and select View -> UAP to select UAP.

@, Sky Analyzer for ASTERIX

File View Analyze Tool Help

Message View r v @"' {

™ Target List View
]

Op ge  List Filter Lua
_Tl Frarmne P+ MNone E
I uap * LDpP
HDLC
T Simple Filter
UDP+HDLC
O’ Lua Filter "
AlR
@  Clear Filter e
UDP+rnanaghlR
Wizesoft+HDLC

i

Figure 2.5: Select Frame Type
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@, Sky Analyzer for ASTERIX

File View Analyze Tocl Help

= Message View r @. Q
I Target List View
“s ge List Filter Lua (le
_Tl ] Frame b — —
UAP F o+ Auto
Simple Filter Standard
® LuaFilter ADS-B v0.23
@ Clear Filter ADS-B vD.26
ADS-B v2.1
ADS-Bw2.4
ADS-B w0.23 Thales
Radar Plot
Radar Raytheon
|

Figure 2.6: Select UAP

For UAP, if Auto UAP is selected, Sky Analyzer for ASTERIX will try to guess what is the correct UAP and
try to decode data with it, but sometimes it may fail and select a wrong UAP, in this case you should
manually select a proper UAP and force the system to decode data with selected UAP.

2.2.4 STEP 4. Inspect data

Once data is correctly decoded, you can use tree view and list view to inspect the detail of ASTERIX
data.

2.2.5 STEP 5. Find data with filter

Normally, you will receive a plenty of data packets from a sensor even in a short time.

And a typical task to analyze ASTERIX is to find flights match some specific conditions. For example,
flights with hijack alert. You can do this in an easy way by using the Filter function.

Here we try to trace flight “CSC8753". Click Filter button in main toobar, input “CSC8753” in callsign
field, and press Apply, packets contain flight “CSC8753” will be shown in the UL.

SinoATC Ltd. 12
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@, 20200618 10.reb - Sky Analyzer for ASTERIX - O X
File View Analyze Tool Help
B0 FYEOO.7. L lbmawae @ 1QA0BR 0O B ¢80 G
= @ N = v/ }
Open Close  Capture Message  List Fitter Lua Clear  Frame uap XML C/C++=  CSV  KML HTML PDF Coverage MNorth Delay Conv Calc RDCU Recorder Playback Help  Exit q
Timestamp Size Dataitem Summary 0000 30 01 01 ££ £f 02 16 58 4d =f 01 a0 42 99 19 32
0010 08 3£ 05 a4 €0 03 c8 78 Ob EopuEciiES - T
23036 |20eD 0o OIS0 T 03 cé 80 00 30 aa 00 00 40 d4 ea 05 30 =0 00 40
23937 2020-06-18 10:59:56.949 93 60 80 la €3 37 a0 04 =8 50 00 e9% 13 4£f 1lb 21 07
23938 2020-D6-18 10:59:57.183 77 el a6 58 40 22 f5 ff df 02 16 58 4d ef 00 a0 7f
o 02 19 2d 02 4% 01 39 60 02 b0 ab 83 54 Ob lc 36
23939 2020-06-18 10:59:37.276 497 4e 08 20 O7 b2 24 bb 33 d3 01 a0 44 62 40 22 =0
23040 2020-06-18 10:5%:57.307  18¢ £f £f 02 16 58 4d ee fe a0 3d 1b 18 1d 02 b4 01
d8 €0 02 cé 78 Oc 2b 0d 30 £3 db Oc a0 01 97 10
23941 2020-06-18 10:59:57.495 43¢ 00 30 aa 00 00 40 01 4c 11 0% 19 5d 05 48 a5 ef
23042 2020-06-1810:59:57.557  34¢ 4023 £5 ££ ££.02 14 58 4d ef 05 e0 23 £7 1b bf
Y Filter - Sky Analyzer for ASTERIX > 25 7% 09 28 0d 12 36 c7 €d
23043 2020-06-1810:59:57.713 27 B 0 40 03 0 On 51 0d Ta
23044 2020-06-1810:59:57.775 372
Callsign CSC8753 Q - - -
23045 2020-06-1210:59:57.978 36 R 10 - Aircraft Identification
23045 2020-06-1210:59:58.041 20
ICAQ Address
23047 2020-06-1310:39:38.258 47
23048 2020-06-18 10:59:38290 21 Level :
23040 2020-06-18 10:50:38.353 407 TR
23950 2020-06-13 10:39:38477  36¢ SAC/SIC li e oover 3 - [ —
23951 2020-06-12 10:3%:38.540 312 p\1\1|n\u| u1\1|1\1|1\n|n\n1 n\1|1\1|1
23052 2020-06-18 10:50:38.758  47¢ e Apply Claee | octer 6 - =0 octer 7 - —- octes 8 - —-
23953 2020-06-1310:39:38.774 92 e ooy [ 1 [ oo o SR S R S N Y e
23054 2020-06-1310:39:38977 3¢ . .
Detaild Description
23055 2020-06-1210:50:50.008 143
23056 2020-06-1210:59:58.170 22 Bit(0-5] | CHAR L |C
23057 2020-06-12 10:59:50.226 281 Bicte-11] |cmam 2 |s
23958 2020-06-18 10:59:59.445 10 Bit[l2-17] | CHAR 3 | C
23959 2020-06-18 10:39:39.445 22 Bir(18-23) | CHAR 4 | 8
23960 2020-D6-18 10:50:59679 92 Bit[24-25] | CRARS |7
Bit[30-25] | CHAR € [ 5
23961 2020-06-1810:59:58.694 67
Bit[3&-41] CHAR 7 | 3
23962 2020-06-1810:59:58.928 93 Sz || mEen
23963 2020-06-1210:59:58.944 22

Figure 2.7: Filter Window
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= o x
File € ool
g -
r L L @1Q0BEE B %5
33 OO0 O.9.450 882880 Tt 08 N. 8 G
Open Close Capture  Message List  Fiter lus  Clear  Frame  UAP XML C/Ce+ CSV KML HIML PDF  Coverage Morth Delay Conv Calc RDCU Recorder Plyback Help Bit | %
Timestamp Size |Datsitem Summary 0000 30 01 dd ££ ££ 02 16 58 4b o5 5£ a0 <7 ec 21 55 .1u
1 2020-06-1310:4130380 479 | | |[v DataBlock 1 0010 08 3£ 05 52 €0 07 bs 78 ok ss|EENEEETIETEEENET W
~ Data Record 1 0020 01 10 01 06 80 e5 00 00 10 00 & 48 02 44 43 07
2 2020-06-1810:41:34374 470 Data Item 1048/010 SAC:022 5IC:088 0030 =3 a8 86 496 22 £5 £f £f 02 16 S& 4b c5 €9 a0 83
3 2020-06-18 10:41:42.376 471 Data Item ID487140 TOD:10:46:34.742 0040 Sc 27 58 27 52 05 63 60 01 bc 78 07 26 Oc 80 bé
0050 cb 2d 60 01 bc <O 00 30 b3 00 00 40 03 24 36 18
AT Dats Item 1043/020 TYPEROLL_CALL CHN1
4 e D:t: ‘t:: ‘mm RHO190.0 THETA.0 0060 25 79 08 82 21 0d 40 22 £d £f ££ 02 16 53 4b c5 .
5 2020-06-18 10:41:50.382 479 Data | (0427070 MG[;E 3}A-40Ti'. § 0070 S5c a0 %a 1d 20 40 08 Oa 03 b0 60 03 bb 73 0= 55 x.T
i Eorea e ata ltem I 0030 0c 40 £8 e3 7d 20 03 as 13 00 30 24 00 00 40 d4
oD e AR Data ltem 1048/090 MODE_C:0341 0090 1a 57 2b a0 04 01 60 B0 3a €5 36 a0 04 dc 50 05
7 2020-06-1810:41:58.364 479 Data ftem 1048/130 SUBFIELDS:02/07 00a0 17 36 dc 36 1d 07 c3 a6 58 40 22 f£5 £f £f 02 16
Data ltem 048/220 ADDR:780B83 00b0 58 4b c5 68 €0 2d 1d 26 ab 03 Sa 03 89 70 03 cc
& 2020-06-1810:42:02.357 479 -
Data ltem 1048/240 ACID:CSCE753 00cO 17 78 04 73 0d 36 b9 d3 7c 60 03 00 00 00 2f £O | . X.=5.6..1
9 2020-06-18 10:42:06360 471 Dats Item 1048/250 BDS:1,0
10 2020-06-18 10:42:14.371 486 Data Item 1048/167 TRACK_NUM:0233 Data Item 1048/240 - Aircraft ldentification
Dats Item 1048/042 X:270420.9 V:252913.8 LSB:M
11 2020-06-1210:4218357 470 . y
Dats Item 1043/200 SPD:443.63 HDG:236.99 Summary
12 2020-06-1810:4222379 486 Data ltem 1048/170 TYPESSR
. ACID:CSC8753
13 2020-06-18 10:4226.350 478 Data ltem [043/230 F:AIR
~ Data Record 2 —
14 2020-06-1310:4230369 470 Diata ltem I048/010 SAC:022 SIC:022 Raw Data in Binary
15 2020-06-1210:42:34351 436 Data Item 1048/140 TOD:10:46:34.820 . . s PR o 5 o o = oD
Data ltem 1042/020 TYPE:ROLL_CALL CHN1 S L Sretes b Stevth CERtRi
e Data ltem ID48/040 RHO:131.6 THETA:55.3 ojlojojal1|1|o|1 ofo 1|1]|0]a oj1/1|1|1|1 afojaf1 ol1/1]1]1
16 2020-06-1310:42:38376 498
17 2020-06-1810:42:42.370 423 Data Item 1048/070 MODE_3/£:3522 SMOOTHED Octet 5 - 5C Octet € - Ed octer 7 - —- Octe & - —-
18 2020-06-18 104246375 455 Data Item 043/090 MODE_C:0344 of1folaaf1falo 211 la]o]0] =T-T=T-T-1-1--T-1-T-1-1-1-
Dats Item 1048/130 SUBFIELDS:02/07
19| 20200618 10:42.30368| 431 Data ltem 1048/220 ADDR:780726 Detaild Description
20 2020-06-18 10:42:54.348 447 Data Item 1048/240 ACID:CHB6225
21 2020-06-18 104258347 431 Data ftem 1048/250 BDS:4,0 N e
I ey Data Item 10487161 TRACK_NUM:0204 Bilocsl L <
s Data Item 1048/042 X:200363.2 Y:138798.7 LSB:M ERcli=inl | Erelo] =
23 2020-06-12 10:43:06335 431 Data Item 1048/200 SPD:478.56 HDG:46.48 Bit(l2-17] | CHAR 3 | C
34 2020-06-18 10:4310344 447 Dats Item 1048/170 TVPESSR Bit[13-23] | caan e | &
Data Item 1048/230 FS:AIR -
25 2000-06-1810:4314337 423 v Dats Record 3 Bit(24-29] | CHARS | 7
Bit[30-25] | CHAR € [ 5
26 2020-06-1810:4318331 455 Dats Item 1048/010 SAC:022 SIC:088
; . Bit[3€-41] | CHAR 7 | 3
27 2020-06-181043:22325 431 Data Item [043/140 TOD:10:46:34.718 .
Data Item 1042/020 TYPEROLL_CALL CHN1 Bic[42-47] | cHAR 8
28 | 2020-06-18 104326334 447 Data Item 1048/040 RHO:134.1 THETA:45 4
29 2020-06-18 10:43:30327 431

Figure 2.8: Tree View
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o = F & O.% & TP SN EENONESN: N NOND) A
v - [ mn = LN

Open Close Capture Message List Filter Lua Clear Frame UAP XML C/C++  CSVY KML HTML PDF Coverage MNorth Delay Conv  Calc RDCU Recorder VJ
Country SAC/SIC Time Stamp Type Track Number Mode 3/A Flight Level Selected Altitude Callsign ICRO Address WGSS4 Coordinates Polar Coordinates

1 Ml cEv  o0z2/088 134,742 Track 233 4077 34100 C5C3753 780BES R:199.5219 T:046.87

2 W cEv 022/088 10: Track 233 4077 34100 C5C3753 780B8S R:199.4414 T:046.98

3 B cEN  022/088 10:46:46.718 Track 233 40778 34100 340%¢ T780BES R:198.4805 T:04€.99

4 Bl cEN  022/088 10:46:50.718 Track 233 40775 34100 34086 780B85 R:197.9922 T:046.95

5 B cEN  022/088 10:46:54.728 Track 233 4077 34100 340%¢ T780BES R:197.5078 T:04€.88 M:23¢

[ Bl cev  o0z2/088 Track 233 4077 34100 34086 780B85 R:197.0195 T:046.93 T:304

7 @ cEn  o022/088 Track 233 4077 34100 34058 T80B8S R:196.5351 T:046.75 M:23¢

8 Ml cEv  o0z2/088 Track 233 40775 34100 340%¢ T80BES R:196.0547 T:046.92

9 @ cHN 022/088 10:47:10.718 Track 233 4077 34100 34086 780B85 R:195.5703 T:046. M:23¢

10 M CHN 022/088 10:47:18.703 Track 233 4077 34100 340%¢ T780BES R:194.6016 T:04€.85 M:23¢

11 M cEN 022/088 10:47:22.703 Track 233 40775 34100 34086 780B85 R:194.1211 T:046.82

12 M CHN 022/088 10:47:26.710 Track 233 4077 34100 340%¢ T780BES R:193.6367 T:04€.70 M:23¢

13 M cEHN 022/088 10:47:30.695 Track 233 40775 34100 34086 780B85 R:193.1523 T:046.85

14 M cEN 022/088 10:47:34.710 Track 233 40778 34100 34058 T80BES R:192.6680 T:046.69 M:23¢

15 WM cEw  o0z2/088 Track 233 4077 34100 340%¢ 780B85 R:192.1836 T:046.74 T:30¢

16 M cEn 022/08; Track 233 4077 34100 34096 T80BES R:191.7031 T:046.72 M:23¢

17 M cEN o022/088 79 Track 233 40778 34100 340%¢ T780BES R:191.2227 T:04€.77

15 M cEN o022/088 Track 233 4077 34100 34086 780B85 R:190.7344 T:046.72 M:23¢

15 M cEN o022/088 9 Track 233 40778 34100 340%¢ T780BES R:190.2578 T:04€.89

20 M cEN o022/088 Track 233 4077 34100 34086 780B85 R:189.7656 T:046.65 M:23¢

21 M cEN o022/088 Track 233 40778 34100 340%¢ T780BES R:189.2891 T:04€.70

22 Ml cEN  0z22/088 Track 233 4077 34100 3408¢ C5C3753  780BES R:128.8047 T:046.65 M:23¢

23 M cEN 022/088 Track 233 40775 34100 34056 CSC8753 780B8S R:188.3281 T:046.69

24 (Ml CHN 022/088 10:48:14.679 Track 233 4077 34100 340%¢ C5C3753  780B8S R:187.8398 T:04€.55 M:23¢

25 Ml CHN 022/088 10:48:18.664 Track 233 40775 34100 34086 C5C3753 780B8S R:187.3555 T:046.68

2¢ Ml CHN 022/088 10:48:22.679 Track 233 4077 34100 340%¢ C5C3753  780B8S R:186.8711 T:04€.5¢ M:23¢

27 Ml CHN 022/088 10:48:26.664 Track 233 40775 34075 34086 C5C3753 780B8S R:126.3906 T:046.66€

Figure 2.9: List View

For advanced use of Filter function, please refer to chapter “Filter”.

2.2.6 STEP 6. Export data

Once you have find some data you are interested, you can then export and save it in other formats.
Here we export the historical data of flight "KTK2422.

Select File -> Export Track List as CSV..., a standard File Save Dialog will appear, you can browse and

save track list as a CSV file.

Later, you can use Microsoft Excel or other compatible application to open and edit this file.
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H - @ = KTK2422 - Microsoft Excel 2 EH - 0O %
HOME | INSERT  PAGELAYOUT ~ FORMULAS  DATA  REVEW  VIEW  ADD-INS  TEAM | ] |
oy X - .| == = = = = AutoSum ~

O, Arial Unicade MS B — 2 Wrap Text General GJ L—‘)) e E)\ @ Fm- %Y H
Paste BIUu-|E-|H-A-|%-|= erge & Center - | B~ G5 » | 4 g4 | Conditional Formatas Cell | Insert Delete Format Cloar- Sort & Find &

- Formatting~ Table~ Styles- | - - - ¢ Filter - Select ~
Clipboard Font & Alignment [ Mumber ] Styles Cells Editing ~
A8 - £ || GBR v

A E © D E F G H I J K iL, n -
1 | Country SAC/SIC Time Stamp Type [rack Numbe Mode 3/A Flight Level Callsign ICAO Address Polar Coordinates WGS84 Coordinate: Speed  Head
2 GBR 070/249 00:04.2 Track 16 72448 3681 KTK2422 4249D2 R:112.2617 T:353.44
3 GBR 070/249 00:08.2 Track 16 72448 3681 KTK2422 4249D2 R:112.7656 T:353.46
4 GBR 070/249 00:12.2 Track 16 72448 3681 KTK2422 4249D2 R:113.2656 T:353.52
5 GBR 070/249 00:16.1 Track 16 7244 3681 KTK2422 4249D2 R:113.7617 T:353.58
g GBR 070/249 00:20.1 Track 16 72448 361 KTK2422 4249D2 R:114.2617 T:353.59
7 GBR 070/249 00:24.1 Track 16 72448 360 KTK2422 4249D2 R:114.7617 T:353.59
8 GBR 070/249 00:28.0 Track 16 72448 361 KTK2422 4249D2 R:115.2617 T:353.63
g GBR T 070/249 00:32.0 Track 16 7244 360 KTK2422 4249D2 R:115.7656 T:353.65
10| GBR 070/249 00:36.0 Track 16 72448 360 KTK2422 4249D2 R:116.2617 T:353.69
11 GBR 0707249 00:40.0 Track 16 72445 361 KTK2422 4249D2 R:116.7578 T:353.73
12| GBR 0707249 00:43.9 Track 16 72445 361 KTK2422 4249D2 R:117.2578 T:353.74
13| GBR 0707249 00:47.9 Track 16 7244 361 KTK2422 4249D2 R:117.7578 T:353.81
14| GBR 0707249 00:51.9 Track 16 72445 361 KTK2422 4249D2 R:118.2578 T:353.84
15| GBR 0707249 00:55.8 Track 16 72445 361 KTK2422 4249D2 R:118.7539 T:353.82
16| GBR 0707249 00:59.8 Track 16 72448 361 KTK2422 4249D2 R:119.2539 T:353.88
17| GBR 0707249 01:03.8 Track 16 7244 360 KTK2422 4249D2 R:119.7539 T:353.91
18| GBR 0707249 01:07.7 Track 16 72448 360 KTK2422 4249D2 R:120.2539 T:353.94
15| GBR 0707249 01:11.7 Track 16 72448 360 KTK2422 4249D2 R:120.7539 T:353.98
20| GBR 0707249 01:15.7 Track 16 72448 361 KTK2422 4249D2 R:121.2500 T:354.06
21 GBR 070/249 01:19.7 Track 16 7244 360 KTK2422 4249D2 R:121.7500 T:354.07
22| GBR 070/249 01:23.6 Track 16 72445 360 KTK2422 4249D2 R:122.2500 T:354.10
KT 4
mo-——+

Figure 2.10: CSV File in Microsoft Excel

Similarly, you can export datil ASTERIX fields to Adobe PDF format, and view/print it with "Adobe
Reader* or other compatible application.

SinoATC Ltd.
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| KTK2422.pdf - Adobe Reader

Toansase - Ao Cepuniiity and Plight seates | 02

Data Item 1048/010 - Data Source ldentifier
Summary

SACOT0SIC:249

Raw Data in Hexadecimal

== T |
| E e e e e e e S|

Raw Data in Binary

- [m] X
File Edit View Window Help ]
= —~ [ - WO [ = RN} = - i
Do 2B B@BESE* ®[ e N0 ® 000 DR - Tonts | Filasign | Comment
- ~
Page Thumbnails Tinl|
Systam dmntncation ot (316)
é Bl @ o Data Record - l0d8 [ ot [ ame | #ex [ oo | Gy | Systom | Tyzo | Worwiuotorsr | oot | Beseriion ]
Raw Data in Hexadesimal | o o e P e ] e e ey Py |
~
Data Item 1048/140 - Time of Day
s s e mlos ool [w [ [oe [as oo [ [ 30 [7=] Summary
List of Dataitems TOD-11:00:20.108
[ Raw Data in Hexadecimal
= T e
 EETI I e e e e ey |
e Raw Data in Binary
[emre | om:iw | wwsam | wme ]
[elefefolsTeJols e s sToTolo s o oo oloTalaaTef -T-T-T-T-T-T-T-]

Data Item 1048/020 - Target Report Descriptor
Summary
TIPEROLL_CALL CHNZ

Raw Data in Hexadecimal

= T ==
T e e e e e e e ey |

Raw Data in Binary

Detaild Deseription

Figure 2.11: PDF File in Adobe Reader
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3 User Interface

3.1 Overview

Sky Analyzer for ASTERIX has a modern and easy to use user interface. The main window composes
of menu bar, tool bars, status bar and main view. All functions can be accessed through main menu,
and major functions can be accessed through tool bar.

Title bar - [m] X
Menu bar
FrY€on.? siuces @ 1A0E80 0 B ¢0 &G
. L n
Open Close Capture  Message Lst  Filter Llua Clear  Frame  UAP TL FEs & D0 0 BF G (b Gy G &F Oty Ehaan Gp G0 -7
aintootbar
Timestamp Size Dataitem Summary 0000 3e 04 fS bf 5d a6 01 01 00 04 3c 80 00 64 51 00
1 2016-01-0101:00:00000 16 ~ Data Block 1 0010 01 €= 51 20 06 74 d4 £8 93 2b 01 be fc af 0% 43 |
v Data Record 1 0020 ef 07 £1 4c 71 cO 19 28 a0 73 d3 Oc a0 7a df 01
2 2016-01-0101:00:00458 44 Data ftem 1062/010 SAC:001 SIC:001 0030 dz 05 c8 05 c2 00 24 00 00 00 00 00 00 éd 60 03
3 2016-01-0101:00:00408 44 Data ftem 1062/015 SVC.ID:000 0040 2= 00 00 01 00 00 €3 Ob 76 Ol 11 01 4e £0 05 c9 | .
0050 00 00 Sf a8 4a 4a 41 33 34 30 32 80 42 37 33 38 . . JJA3402.B738
00 Data ltem 1062/070 TOD: :09.000
4 2016-01-0101:00:00.698 16 D:l: It:x logws WGSeh 75 E0INT2EA660E 0060 4d 52 4b 53 49 50 47 53 de 00 00 01 0a 17 2d 80 | MRKSIEGSN..... -
-01-01 01:00+ 0070
3 |2016-01-01 010000722 6 Data ltem 1062/100 X%:2115620 V:-243308.0 LSB:b || 000
6 2016-01-0101:00:00.000 80 Data ftem 1062/185 VXi111.50 Wi-21200 LSBM/! || ep o1
7 2016-01-01 01:00:00438 68 gm:ta"‘:ggg %‘;gﬁ;’?f;g 0020 bL N
ata ltem : 00b0 00 €3 54 00 01 6d 96 60 05 a2 ce fd 8f 21 03 8% | .h
§ |G 00101000450 0920 Data ltem 1062/040 TRACK NUM:2934 00c0 00 7b 00 48 01 01 Ol Se fc 0Ol £0 00 00 bf 4d a4 | . f.H..." M
9 2016-01-0101:00:00.608 20 Data ltem 1062/080 TRACK_STS:MULT!
10 2016-01-01 01:00:00.000 42 Data ltem 1062/200 T:UND LUND V:LEVEL Data Record - 1062
11 |2016-01-01 01:0000453| 20 Data ltem 1062/136 LEVEL:37025 LSB:FT
-01-01 01:00:00- Data Item 1062/220 VH:0.00 LSE:FT/MIN Raw Data in Hexadecimal
12 2016-01-0101:00:00498 33 Data Item 1062/390 SUBFIELDS:08/14
13 2016-01-01 01:00:00.698 40 v D""“D “:“;"’zlow";z";:éeo‘; scoon Ootet 1 Octet 16
ata ltem : :
g Dat e HGZAD13 SVC 1000 o Los [ vs [ | rc [ os [ o | o0 [os [ 3]s | ae [ o1 [
15 2016-01-D101:00:00458 59 Data Item 1062/070 TOD:00:36:09.000
. Data Item 1062/105 WG584:361637N1285728E 40 | 7B | BO | SD |82 | 02 |20 |82 |08 |20 |00 00| 00|¢C3]0l|0L
16 Data ltem 1062/100 ¥%:224468.0 V:-130855.0 L SB:l o1 |4 | ¥0 |04 | Bo |00 00| |- |—=]—=|--]-=|-]-]--
17 2016-01-0101:00:00.698 64 Data ltem 1062/185 VX:-153.50 V¥:103.25 LSB:M/:
18 2016-01-01 01:00:00.000 1273 Data ltem 1062/060 MODE_3/A:3257 List of Dataitems
Data ltem 1062/320 SUBFIELDS:03/28
Data Item 1062/040 TRACK_NUM:0195
Data Item 1062/080 TRACK_STS:MULTI I0€2/010 | Data Source Identifier 02 SAC:001 SIC:001
Data Item 1062/200 T:UND L:UND V:LEVEL I0€2/015 | Service Identification 01 | svc_ip:ooo
Data ftem 1062/136 LEVEL:30000 LSB:FT I062/070 | Time of Track Information 03 | Top:00:36:03.000
Data Item 1062/220 VH:0.00 LSB:FT/MIN
~ Data Record 3 I0€2/105 | Calculated Position in WGESE4 C i s WGSE84:3€1€3TN1285728E
Data ttem 1062/010 SAC:001 SIC:001 I0€2/100 | Calculated Track Position (Cartesian) 0e X:2244€8.0 Y:-130855.0 LSB:M
Data ltem 1062/015 SVC_ID:000 I0€2/165 | Calculated Track Velocity (Cartesian) 04 | VE:-153.50 V¥:103.25 LSB:M/S
Data Item 1062/070 TOD: :09.000 I0€2/060 | Track Mode 3/3 Code 02 | MODE_3/A:3257
Data ftem 1062/105 WGS84:364438N1283137E I0€2/380 | Rircraft Derived Data 15 | SUBFIELDS:03/28
Data Item 1062/100 X:184679.0 Y:-79983.0 LSB:M 0627040 | Track Number PP I ———
Data Item 1062/185 VX:226.25 VV:30.75 LSB:M/S =
Data Item 1062/040 TRACK_NUM:D072 I0€2/080 | Track Status 04 TRACK STS:MULTI

Status bar

Figure 3.1: Main Window

3.1.1 Title Bar

Title bar is on top of main window.
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If a file is loaded, file name will be shown in title bar; if live UDP multicast is enabled, IP address and
port number will be shown in title bar.

., radar.rex - ASTERIX Protocol Analyzer

Figure 3.2: Title Bar with File Name

L Mcast 230.1.1.20:15479 - ASTERIX Protocol Analyzer

Figure 3.3: Title Bar with Multicast IP & Port

3.1.2 Menu Bar
Menu bar is below title bar. All functions can be accessed through cascade menu.

@, Sky Analyzer for ASTERIX

File View Afnalyze Tool Help

Open File... Ctrl+0 B" Q

Closze File
lua  Cle:
Recent Files L
| Surmr
' 3 Capture Live Data... Ctrl+ M

Save Data as XML...
e Save Data as C/C++ Struct...

Save Target List as CSV...
o 2ave Detail Description as HTML...
Save Detail Description as POF...

Export Targets to Google Earth KML...
| @ Exit
| ||

Figure 3.4: Menu Bar

Below is a list of menu/submenu of Sky Analyzer for ASTERIX with description of each menu items.
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Menu Menuitem

File

View

Open File...

Close File
Recent Files

Capture Live Data

Save Data as
XTML...

Save Data as C/C++
Struct...

Export Track List as

CSv...

Save Detail
Description as
HTML...

Save Detail
Description as
PDF...

Export Targets to

Google Earth KML...

Exit
Message View

Target List View

Frame

UAP

Simple Filter
Lua Filter
Clear Filter

Description

Open data file and load data
packets

Close data file
List recently opened files

Capture live data from network

Export displayed data into XML
format file

Export selected data into C
struct

Export displayed list in track
view into CSV format file

Export displayed ASTERIX detail
into HTML format file

Export displayed ASTERIX detail
into PDF format file

Export displayed tracks into
Google Earth KML format file

Exit Analyzer application
Switch main Ul to message view

Switch main Ul to target list
view
Select frame type to decode
data

Select UAP to decode data
Open simple filter window
Open Lua filter window

Cancel current filter

Note

Compatible with Microsoft Excel

See detail in relative section

See detail in relative section

See detail in relative section

SinoATC Ltd.
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Menu Menuitem Description Note
View- None No frame, means ASTERIX data  This is the default value
Frame is directly included in data
packet
HDLC HDLC frame This is typical frame when data
is read from synchronous serial
line
UbDP MAC + UDP frame This is typical frame when data
is captured from LAN
View- Auto Automatically select proper This is the default value. User
UAP UAP should manually select correct
UAP if the it is wrong
Standard Standard UAP defined in
ASTERIX standard
ADS-Bv0.23 UAP defined in ASTERIX Cat021
version 0.23
ADS-B v0.26 UAP defined in ASTERIX Cat021

ADS-Bv0.23 Thales

Radar Plot

Radar Raytheon

AnalyzeRadar Coverage

Tool

Radar North Marker
& Sector Missing

Message
Transmission Delay

File Converter...

Data Recorder...

version 0.26

UAP used by Thales ADS-B
ground station

UAP defined for plots in
ASTERIX Cat001

UAP used by Raytheon radar

Open radar coverage analyze
tool

Open radar north marker and
sector message missing analyze
tool

Open radar message
transmission delay analyze tool

Open file format conversion
tool

Launch Data Recording and
Playback application

See detail in relative section

See detail in relative section

See detail in relative section

See detail in relative section

SinoATC Ltd.
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Menu Menuitem Description Note
ASTERIX Launch ASTERIX Playback
Playback... application
ASTERIX Simulator ~ Launch ASTERIX Simulator

application
Options... Open Options Window

Help Contents Show help
Open Samples Open and load sample data
Install License... Install license file for registered

user
Website Open default web browser and
open ASTERIX Toolkit website
About Show About Window

Note: Some menu items listed above may not appear in your application, or not applicable in
your application, it depends on your license type.

3.1.3 Tool Bar

There are several tool bars.

Main toolbar contains commonly used function tool buttons, the function is exactly the same with
corresponding menu item.

Filter toolbar is used for filter function.

3.1.4 Status Bar

Status bar is at the bottom of main window, it shows status information and application message.

3.1.5 Main View

In the middle of main window, it is the main view. There are different types of view, message view and
target list view.
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3.2 Message View

Message view is the default view after Sky Analyzer for ASTERIX starts up. In this view, ASTERIX data is
shown in a tree style hierarchy.

1, 20170412052017041206 serial 17.rex - ASTERIX Protocol Analyzer - u] X
File View Analyze Tool Help
OSONN =.2. 000000 @ AOO S & © OO0 p
File Messt Stop | Tree Track Frame  UAP XML C/C++ CSV KML HTML PDF Coverage North Delay Comv Record Playback Simulator Help Exit
Filter | ~] s o Apply X Clear
Timestamp Size * | Dataitem Summary QOLLIRETRNIEE ££ £7 02 46 £9 23 86 6b a8 3c 0Oa b9 97
[ S v Data Block 1 pLrlig2a 14 05 54 e0 12 02 bl 78 Oa ee 0d 33 b6 e7 9¢
2979 2017-04-12 05:03:08.853 56 v (o= (LFl>0 01 fa &1 c1 00 00 00 00 17 00 la 07 28 dS5 &6}
ata Recor po3o [AEINE 42 ea 12 00 00
2980 2017-04-12 05:03:08.958 16 Data ltem 1048/010 SAC:070 SIC:249
03 Data Item 1048/140 TOD:05:03:08.835
2981 2017-04-12 05:03:08.983 56
20170112 05:05:00.008] 56 Data Item 1048/020 TYPE:ROLL_CALL CHN2 Raw Hex Data
2982 s e Data Item 1048/040 RHO:156.0 THETA:261.0 N
2983 2017-04-12 05:03:09.087 16 Data ltem 1048/070 MODE_3/A:5024 SMOOT | Data Record - 1048
2084 2017-04-12 05:03:00.210 16 Data Item 1048/090 MODE _C:0341
Data Item 1048/130 SUBFIELDS:03/07 : :
2985 2017-04-12 05:03:09.334 16 Raw Data in Hexadecimal
Data Item 1048/220 ADDR:780AEE
2986 2017-04-12 05:03:09.461 16 Data Item 1048/240 ACID:CSNG998 Dctet 1 Octet 16
2987 2017-04-12 05:02:09.583 16 Data Item 048/250 BDS:1.7 FF F7 | 02 | 48 | Fo 23 | =& 5 | A% | 9C |0 | B3| 92 | 28| 14 | 0%
Data Item 1048/161 TRACK_ NUM:0026
2088 2017-04-12 05:02:09.715 16 ata ltem 1048/ - 5402012 |02 |5 |72 |oaee|on|33|me|e7|oe|20|0a|m
Data Item 1048/200 SPD:402.54 HDG:300.09 = =
2989 2017-04-12 05:03:09.830 16 Data ltem 1048/170 TYPESSR 81 | C1| 00| 00|00 00|17 |00|1A|07 |28 |DS5|66|46[20]|F5
2990 2017-04-12 05:02:09.867 16 Data Item 1048/230 FS:AIR . .
List of Dataitems
2991 2017-04-12 05:03:09.944 64
2992 2017-04-12 05:03:09.963 40
2993 | 2017-04-12 05:03:09.995| 72 1048/010 | Data Scurce Identifier 0z 70 SIC:24%
1048/140 | Time of Day 03 5:03:02.835
2994 2017-04-12 05:03:10.004 20 . .
Target Report Descriptor o1 TYPE:ROLL_CALL CEN2
2995 2017-04-12 05:03:10.029| 56 Measuzed Fosition in Bolax Co-crdinates 04
2996 2017-04-12 05:03:10.080 16 1042/070 | Mode-3/R Code in Dctal Representation 02
2997 2017-04-12 05:03:10.089 1 1048/090 | Flight Level in Binary Representation 02
29?5?7%5& E%HCFL Data Block/ Record/ltem T0az130 | rac-Di@bARIECM-iN-Detail 04
/. Lircraft Rddress 03
2999 2017-04-12 05:03:10.183 56
1048/240 | Aircraft Identification 06 -
3000 2017-04-12 05:03:10.219 56 .| ¢ >« »
Trail license. Please upgrade your license at http:/fwww.asterixtk.com/upgrade.html

Figure 3.5: Tree View

The message view composes of four parts:

« Data packet list

« Data block/record/item tree
+ Raw hex data

+ Data record/item detail

3.2.1 Packet List

Packet listis on left of tree view, loaded data packets are shown in this list. A sequence number, times-
tamp and size is displayed for each data packet.

Thetimestamp hereisthereceiving UTC time, if datais loaded from file, it means the time when packet
is saved into the file.
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Note: For some file formats, timestamp is not available, the timestamp field will be displayed as
“N/A”.

Note: For some file formats, timestamp has only valid time, and no valid date, the timestamp
field will be displayed with only time.

When one packet is selected, its content will be displayed in the raw hex data panel.

When one packet is selected, system will try to decode it with selected frame and UAP. If it can be
successfully decoded, the structure of this data packet will be display in the data block panel.

3.2.2 ASTERIX Tree

ASTERIX tree is in the middle of tree view, it shows standard ASTERIX data struct in a tree style hierar-
chy, which are:

« Data Block
« Data Record
« Dataltem

The concept of these terms are defined in Eurocontrol ASTERIX documents.

The encoding policy supported by Sky Analyzer for ASTERIX is:

« One data packet can include one or more data blocks
« One data block can include up to 32 data records
» One data record can include up to 32 data items

When one data block or data record or dataitemis selected, the corresponding data will be highlighted
in raw data display panel.

When one data record or data item is selected, the decoded ASTERIX fields will be displayed in detail
in detail panel.

3.2.3 Raw Data Display

Raw data display is on top-right of tree view. Data of data packet will be shown in hexadecimal format
init. If one data block/record/item is selected, the corresponding data will highlighted.
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3.2.4 Detail Display

Detail display panel is on bottom-right of tree view. It is a standard web browser, when a data
record/item is selected, a HTML page will be generated and displayed in detail display panel.

The content in this panel depends on the selected data.

3.3 Target List View

Target list view is used to display important properties of aircraft in a table.

(L Ips.rex - ASTERIX Protocol Analyzer - o x
Fle View Analyze Iool Help
DMOMN '@@O@VQQ@@O:’VUQ«GUB %
File Mcast Stop Tree Track Frame UAP XML C/C++ CSV KML HTML PDF  Coverage North Delay Conv RDCUVi RDCUEx Record Playback Simulator Help Exit <
Filter | ~| #flua o Apply X Clear
Country SAC/SIC Time Stamp Type Track Number Mode 3/A Flight Level Callsign ICAC Address Polar Coordinates WGS84 Coordinates Speed Heading A
6l 050/013 08:09:59.562 Plot 454758 0360 TVSeVS 490369 R:069.0898 T:068.22
a2 050/013 08:09:59.640 Plot 0552 0350 WZZ44l 471F85 R:078.8203 T:075.58
63 050/013 08:09:59.601 Plot 14525 0390 WZZ965 471F5A R:063.3945 T:071.48
-1 050/013 08:09:59.648 Plot 51555 0260 10T224 4BADA2 R:057.2109 T:076.10
&5 ™ DEU 050/013 08:09:59.656 Plot 4613 0380 SHD4PM 3COR4F R:081.5000 T:076.58
a6 050/013 08:09:59.664 Plot 44353 00lg TVQE556 49D365 R:027.8789 T:077.52
a7 050/013 08:09:59.664 Plot 73338 0005 AFEE9PK 4690FS5 R:000.3438 T:077.49
&5 & TUR 022/005 08:09:58.234 Track 192 14445 0370 CRI3182 4BD147 R:071.8063 T:276.48
69 8 TUR 022/004 08:09:58.242 Track 4064 23575 0340 SHS6LW 4BCCAA R:040.1875 T:219.33
70 ™ DEU 048/163 08:08:59.578 Flot 7124 0350 DLH1742 3C55A2 R:068.3945 T:151.85
71 B TUR 049/163 08:09:59.531 Flot 3253 0360 THYEMF 4BREF4 R:104.8047 T:147.55
72 048/163 08:09:59.710 Plot 0110 0370 WZZ113 471ERE R:104.2969 T:164.41
73 050/013 08:09:59.656 Plot 73445 0360 AUI4NN 50814D R:073.7148 T:076.90
T4 050/013 08:09:59.562 Plot 45475 0360 TV56VS 49D369 R:069.0898 T:068.22
75 050/013 08:09:59.640 Plot 0552 0350 WZz44l 471F85 R:078.8203 T:075.58
76 050/013 08:09:59.601 Plot 14525 0330 WZZ965 471F3A R:063.3945 T:071.48
77 050/013 08:09:59.648 Plot 51558 0280 LOoT224 48ADA2 R:057.2109 T:076.10
7¢ ™8 DEU  022/005 08:09:58.203 Track 3170 71438 0330 DLHEOMC 3C55A1 R:127.5977 T:274.75
79 022/005 08:09:59.968 Track 2
80 022/005 08:09:58.195 Track 2788 26065 0076 SWR225Z 4B19ED R:083.9922 T:274.39
g1 BN FRE 022/005 08:09:58.210 Track 3238 71425 0370 FHFKC 399542 R:125.7617 T:275.23
g2 ™= DEU 022/005 08:09:58.195 Track 1107 26235 0264 DLH3AC 3C544D R:133.3828 T:275.27
g3 & GBR 022/005 08:09:58.218 Track 444 47608 0400 BRAW162 4005C1 R:145.4102 T:275.69
v

Figure 3.6: Track View

The columns in this table are:

Column Description Note

Country Country of the aircraft, according toits  If some ICAO address can’t be
ICAO address recognized, airdb should be updated

Reception Time when data packet is received
Time
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Column Description Note

SAC/SIC SAC/SIC of sensor This is useful when data comes from
multiple sensors

Time Stamp Time of source data The meaning of this time is defined by
corresponding ASTERIX category,
normally it is time of measurement

Type Plot, Track & ADS-B

Track Track number Valid only when type is “Track”

Number

Mode 3/A Mode 3/A code, suffix ‘S’ means

“smoothed”, ‘G’ means “garbled”

Flight Level Mode C code

Selected Selected altitude

Altitude

Callsign Mode-S callsign

ICAO ICAO 24-bit address of aircraft

Address

WGS84 Co-  Latitude and longitude Valid for ADS-B, Mlat and system track

ordinates

Polar Coor-  Rho and theta Valid only for radar

dinates

Range Range

Azimuth Azimuth

Speed Ground speed

Heading Heading

Cartesian Velocity in Cartesian plane (X-Y)

Velocity

Doppler Doppler velocity

Velocity

Vertical Climbing and descending rate

Rate

SinoATC Ltd.
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When system reads one qualified data record, it will extract properties included in the data record,
and generate a row. If any property is not applicable to the data record, the corresponding column

will be displayed as blank.
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4 Filter

4.1 Overview

The filter function allows you to show only the data you are interesting, it is useful when you want
to

Trace one or several specific aircraft(s), by track number, callsign or Mode-S address;

Find data with special characteristic, e.g. SSR is 7500;

Analyze data from a specific sensor;
- Etc.

When a filter is applied

+ System will check all loaded data, and shows only data which can match the filter;

+ System will check new incoming data (read from file, or received from network), and shows only
data which can match the filter;

« Unmatched data will not be shown, but still kept in memory.

There are two types of filter, simple filter and Lua filter.

4.2 Simple Filter

4.2.1 Introduction

A simple filter, as explained by its name, is simple and easy to use. It’s useful when you just need to
filter data with one condition, e.g. callsign is CSC8753.

In main window, when clicking on Simple Filter button, it will open a Simple Filter Window.

® O

Filter Lua Clear

Figure 4.1: Simple Filter Button
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Y Filter - Sky Analyzer

Callsign

| Sguawk

C5CE8753

ICAQ Address

Level
Track Mumber

SAC/SIC

Figure 4.2: Simple Filter Window

When clicking on “Clear” button, the filter will be cancelled.

® 0

Filter Lua

Clear

Figure 4.3: Simple Filter Cancelled

Warning: If a large number of messages have been loaded, system need to reload all data when

you cancel a filter, this process could take a while and cause Ul no response for a short time. It

will recover when all data is reloaded.

4.2.2 Syntax

The syntax of simple filter is:

Filter Field Description Example Note
Callsign Callsign KAL937
Squawk Squawk 3562 Range 0000-7777
ICAO Address  24-bit ICAO TF1E00
Address
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Filter Field Description Example Note
Level Flightlevelband  290-380  The lower level must be less than the upper
level
Track number  Track number 65
SAC/SIC Sensor SAC and 126/31
SIC

4.3 Lua Filter

4.3.1 Introduction

Lua filter, is based on Lua script language. You can use Lua script to write a complex filter, and match
specific data you are interesting.

For example, with Lua filter, you can match data which is

for aircrafts belong to Lufthansa (DLH), registered in Germany, with flight level between F290 to
F320, and are in emergency status.

To use lua filter, first you need to click on the “Lua” button in main toolbar.
.
-
®& O
Filter Lwa Clear

Figure 4.4: Lua Filter Button

Then a Lua Script Filter Window will appear.
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L Lua Script Filter - ASTERIX Protocol Analyzer *

Title |Untitled Lua Filter

T
-l

The following variables from ASTERIX data have been extracted and set:

record =

{
category /434
sac A2
sic A252
msgtype  Aftrack
tracknum /798
squawk /3065
collsign  A/SAIT400
icaoaddr /718932
flightlevel /31000

}

17

__JJl

Result |

Test Apply

Figure 4.5: Lua Filter Window

In this window, you can type any valid Lua script. A syntax highlight mechanism similar with any code
editor has been integrated into this window, so you can detect potential errors in script when you type
them.

Please be aware of the green color comments in this window, those are preset data which can be used
to test your script. When you finish your filter script, you can click on “Test” button, and system will
try to use you script to match data in comments, and show matching result in the “Result” text field.
The result can be:

« True, your script match test data and return true.
« False, your script doesn’t match test data and return false.

« Error, there is error when interpreting your script, an error message will be shown in “Result”
text field.
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L Lua Script Filter - ASTERIX Protocal Analyzer *

Title |Untitled Lua Filter

-l
The following variables from ASTERIX data have been extracted and set:

record =

{
category /434
saC A2
sic S22

msgtype  Aftrack
tracknum /798
squawk /3065
collsign  A/SAN40
icoooddr /18932
flightlevel /31000

!

|

if (record.squawk == 3065)
then
return true:
else
return false
end

Result |Script return true |

_ Apply || Close |

Figure 4.6: Lua Filter Test Success
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L Lua Script Filter - ASTERIX Protocal Analyzer *

Title |Untitled Lua Filter

T
-l

The following variables from ASTERIX data have been extracted and set:

record =

{
category /434
sac A2
sic Si252

msgtype  Aftrack
tracknum /798
squawk /3065
collsign  A/SAIT400
icaoaddr /718932
flightlevel /31000

/

=TT
A1

if (record.squawk = 3063)
then
return true:
else
return false
end

Result |[string “function match(record)..."]:1%: ')’ expected near '='

Apply Close

Figure 4.7: Lua Script with Error

When your script is ready to use, you can click “Apply” button to apply the filter, or click “Close” button
to close this window without applying the filter.

When click on “Clear” button in main toolbar, the filter will be cancelled.
& O
Filter Lua Clear

Figure 4.8: Filter Cancel Button
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4.3.2 Syntax

The syntax of Lua script language can be found at Lua website. The Lua version used by Lua filter is

5.3.

Every time, when system need to check if one data record can match the filter or not, it will use the

data to construct a Lua table name record. The following fields are included in the record table:

Field

category
sac

sic
msgtype
tracknum
squawk
callsign
icaoaddr

flightlevel

Description

ASTERIX category number

Sensor SAC

Sensor SIC

Message type, can be north, sector, plot, track
Track number

SSR code

Callsign

ICAO 24-bit address

Mode-C level in feet

If any field is not applicable, it will be set to n-i 1.

Example

34

12

252
“track”
798

3065
“SAl1401”
18932
31000

The filter script should check if the data contained in record can match its purpose or not. If match,

the script must return true, and the record will be kept in result; if not match, the script must return

false, and the record will beignored.

Example:

if (string.sub(record.callsign, 1, 3) == "DLH" and record.squawk == 7500)

then

return true;
else

return false
end

This script means, if the callsign in record starts with “DLH” and squawk is 7500 (hijack), the data will

match the filter and be kept in result, all others will be ignored.

SinoATC Ltd.
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5 File Converter

5.1 Overview

File Converter is a tool which can make conversion between different recording formats.

It reads data packet from input file, extract payload data from frame, and save data into another file
format.
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l_L File Converter - ASTERIX Protocol Analyzer x

Input

File Hame ||...|

File Twpe AsterixzTk Recording * Frame Type Ho Frame -

Output

File Hame

File Twpe AsterixzTk Recording -

Info

Conrert Clear Log Cloze

Figure 5.1: File Converter

5.2 Usage

5.2.1 Input

File Name, the input file path. File must be readable.

File Type, the input file formats. Different with other functions, File Converter will not automatically
detect file format, it will try to read file according to the file format selected here.
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Input
File Hame

File Tupe

Output
File Hame

File Twpe

Info

L File Converter - ASTERIX Protocol Analyzer

s

hsterixThk Recording

#=terixTk Recording
AsterixTlk Inde:x
topdump Capture

Eaw ASTERTX Recording
RDCY Recording

pirHet Log

ATMSys Recording
DISCC Log

CaptMs Lo Recnrding

* | Frame Type Ho Frame -

Conrert

Clear Log

Cloze

Figure 5.2: Input File Type

Note: Depending on your license type, different file formats will be listed here.

Frame Type, the frame type of data packets contained in input file.

SinoATC Ltd.
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L File Converter - ASTERIX Protocol Analyzer x
Input
File Hame ||...|
File Twpe AsterixzTk Recording * Frame Type
Ho Frame
Output
File Hame

File Twpe AsterixzTk Recording -

Info

Conrert Clear Log Cloze

Figure 5.3: Input Frame Type

Note: File Converter will extract payload data according to selected frame type, and save it into
output file. So if you want to keep the original frame in output file, you should select “No Frame”
here.

5.2.2 Output

File Name, the output file path. File must be writable.

File Type, the output file formats. File Converter will save output file into selected format regarding
less the file name suffix.
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l_L File Converter - ASTERIX Protocol Analyzer x

Input

File Hame ||...|

File Twpe AsterixzTk Recording * Frame Type Ho Frame -

Output

File Hame

File Twpe |AsterixzTk Recording -

AsterixThk Recording
Info Faw #STERTY Recording
DataRF Recurdin; Verzion 1

Conrert Clear Log Cloze

Figure 5.4: Output File Type

5.2.3 Information

When you press Convert button, File Converter will starts to make conversion and logging messages
will be displayed in info panel. Error messages will be shown when error occurs during the conver-
sion.
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. File Converter - ASTERIX Protocol Analyzer

Input

s

File Wame |C:AASTDATA sample/radar. rex

File Twpe AsterixzTk Recording

Output

* Frame Type Ho Frame -

File Wame |C: AASTDATA sample/radar. ast

File Twpe FRaw ASTERIE Recording -

Info

LIT

[11
[11
[11
[11

[11
[11
[11
[11

[11

D33
(33
D33
(33
[11:
[11:
D33
233
RCKH
(33
[11:
[11:
(33

33
33

33
33

T ] Ty

19] 42500
12] 43000
18] 43800
19] 44000

18] 44800
197 45000

18] 45800
12] 45000
19] 4500
12] 47000

18] 47500
18] 47892

AL pPAarCELS

data pakecets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets
data pakeets

19] Comvertion finish.

oI T
converted
converted
converted
converted
comverted
converted
comverted
converted
comverted
converted
comverted

converted, =ize 1664200 bytes

Conrert

Clear Log

Figure 5.5: Log Messages

Cloze
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6 Export to Google Earth KML

6.1 Overview

Sky Analyzer for ASTERIX provides a tool to export tracks into KML format, and later it’s possible to
visualize the tracks in Google Earth application.

To generate KML file, the ASTERIX data record must contain the following information:

+ Valid track number or ICAO 24-bit address
« Valid position in WGS-84 coordinates

For CAT062, it requires

+ 1062/040 - Track Number
« 1062/105 - Calculated Track Position (WGS-84)
+ 1062/380 - Aircraft Derived Data, subfield #1

6.2 Operation

The Google Earth KML export dialog is as below.
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—L KML Export - ASTERIX Protocol Analyzer x

Flight Identification

Tdentify flight by |Track Humber -
TCAD 24-bit Address

ML Style

(@ Static Tracjectory () Dymamic Track

Flight Level

For plot with invalid level/mode—c

(@ Uze level from previous plet () Set level to zero (0)

Save and Load

Save EML file to |C:fASTDATM5mp1efﬂights.kml |

Google Earth iz detected at | |

[] autoe load in Google Earth

Cancel

Figure 6.1: KML Export Window

It composes the following options:

Option
Flight
Identification

KML Style

Flight Level

Save KML file
to

Google Earth
is detected at

Auto load in
Google Earth

Description

One aircraft should be identified and distinguished by track number or ICAO
24-bit address.

It’s possible to generate two types of KML, static and dynamic. A static KML will
show static trajectory of each aircraft; A dynamic KML will show flight animation.

If flight level doesn’t exist in data record, it’s possible to use the flight level in
previously received data record of the same aircraft, or just set it to zero.
Location to save KML file.

If Google Earth is installed, system will detect its installation path.

Launch Google Earth and load generated KML.

SinoATC Ltd.
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7 Radar Coverage Analyze

7.1 Overview

The radar coverage analyze tool aims to generate radar coverage map in different levels, by using
historical plots. Internally, the coverage surface of each level is divided into many sector cells. The
angle of each cell is 1 ACP (~0.08789°), and the edge length is 1 NM.
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SECTOR CELL

Figure 7.1: Radar Coverage Sector

When more than 3 plots are detected in one cell, this cell will be marked as “covered”. And with enough
plots of different azimuth and distance from radar site, it’s able to determine the coverage of every cell
and finally get the coverage map of the whole surface. Considering most civil flights operate in limited

predefined routes, to get a full coverage map it may need a long period (more than one month) of
recorded plots.
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7.2 Preparation

To generate an useful coverage map, you need to prepare recorded radar plots in ASTERIX CAT001 or
CAT048 formats. And the following data items shall exist.

For CAT001

« 1001/010 - Data Source Identifier
+ 1001/040 - Measured Position in Polar Coordinates
+ 1001/090 - Mode-C Code in Binary Representation

For CAT048

+ 1048/010 - Data Source Identifier
+ 1048/040 - Measured Position in Slant Polar Coordinates
+ 1048/090 - Flight Level in Binary Representation

Plots are preferred as they are not filtered by radar tracker software. However tracks are accepted and
measured as they are not smoothed by radar tracker.

Recording shall be stored in XML recording file format (.rex files). The File Converter can be used to
convert files in other formats into REX format.

7.3 Main Window

7.3.1 Introduction

The main window of radar coverage analyze tool is as below.
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@ Radar Coverage Analyze - ASTERIX Protocol Analyzer

Fle Analyze Window

-

1 & W

Wew Open Save Save As  Config

Radar

Hame: Demo Radar

SAC/SIC. 255/256 Verify: HO
Format' CATOD8/034/048
UAF: AUTOMATIC

Maximan Coverage: 260 HI

Process

Feed Dir: o: FASTDATAS coverage/feed

Cuarrent File: HULL
Frame: HONE

Level Range: O — 400 FL
Layer: 100 FL

Statistic

Ld

Process

Stop Close

Data Fackets (Good/Total): 51711021 f 51712395 [100.00%]

Data Blocks (CATO01/002): 0 F 1

Data Blocks (CATO34/045): 10682800 / 40906178

Data Records {Qualified/Total): 34920176 / 40906178 [85.378]
Data Records (Filtered by SAC/SIC): 0 [0. 00%]

Data Records (Filtered by Level):
Data Records (Filtered by Range):

Meszages

5888295 [14.39%]
97708 [0 243]

1024

& Save Chart

[20:37:45] Loading configuration ..
[20:37:45] Loading file list...
[20:37:45] 455 files loaded
[20:37:45] Loading statisties. ..
[20:37:4E] Loading coverage cells..
[20:37:45] Create coverage surface:
[20:37:48] Create coverage surface:
[20:38:00] Creats coverage surface:
[20:38:13] Create coverage surface:

[20:38:26] Create coverage zurface:
[on- -and A204 a1 1

layer = 0, coverage = 250

Layer = 100,
Layer = 200,
Layer = 300,
Layer = 400,

d.d

coverage = 260
coveraze = 750
coverage = 250
coverage = 250

Figure 7.2: Radar Coverage Window

It composes of the following parts:

Actions

Menu and tool bars, including select-able menu items and tool buttons for different actions.

Messages

On bottom of the window, messages and logs are shown here.

Information Panel

On left of the window, displays important configuration and statistic information.

Coverage Chart

On right of the window, the coverage map of selected level will be displayed here.

SinoATC Ltd.
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7.3.2 Actions

ActionsDescription

New Create a new analyze
Open Open and load analyze from an existing SQLite database file
Save Save current analyze to a SQLite database file

Save Save current analyze to a new SQLite database file
As

SettingOpen configuration window
ProcessStart or continue processing

Stop  Stop processing. The process will exit when current file is finished. It could take quite a
while if current file is big. This is to avoid plots in current files are processed twice if you
continue processing later.

Close Close the radar coverage analyze window
Layer Select one layer to display its coverage chart

Live  Update chart display during process. Display it could slightly increase processing speed if
Up-  thereisabigamount of data
date

Save Save current coverage chart to a SVG image file
Chart

7.3.3 Statistics

Name Description

Data Packets - All data packets that have been read and processed from recording files
Total

Data Packets - Data packets that can be correctly decoded. If this value is too low, check if
Good frame type is correct.

Data Blocks - Data Blocks of CAT001

CAT001
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Name Description
Data Blocks - Data Blocks of CAT002
CAT002
Data Blocks - Data Blocks of CAT034
CATO034
Data Blocks - Data Blocks of CAT048
CAT048
Data Records - All data records extracted from data blocks
Total
Data Records - Data records with plot or track that can be used to update radar coverage
Qualified map
Data Records - Data records ignored due to its SAC/SIC doesn’t match configuration
Filtered by
SAC/SIC

Data Records -
Filtered by Level

Data Records -
Filtered by Range

Data records ignored due to its level is lower than minimal level, or its level
is greater than maximum level, or its level is not valid

Data records ignored due to its distance is greater than radar maximum
coverage, or its range is not valid

7.4 Configuration Window

7.4.1 Introduction

The configuration window is as below.

SinoATC Ltd.
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@ Radar Coverage Analyze - ASTERIX Protocol Analyzer >
Radar fnalyre
Hame |Demo Kadar| [ ] Verify SAC/SIC
SN:_."{SIE ZFR : ZFE : M:i. nirn:al Lew El ':FL:' ] :
Format CATOOS/034/045 - Maximum Level (FL) |400 '3
AP | Automatic = Level per Layer (FL) (100 %
Maximum Coveraze (HM) (250 |3
Frame Type [Hone -
Feed Dir |o: ASTDATA coverage/fead
0K Cancal
Figure 7.3: Radar Coverage Config Window
It contains parameters used for generating radar coverage map.
Parameter Description Constraint
Radar The name of radar for analyze. Any literal
Name text
SAC System Area Code, used to filter data from other sensors 0~255
SIC System Identification Code, used to filter data from other sensors 0~255
Format Data format for Mode-S radar or conventional radar
Maximum  Radar maximum coverage, any plots far from this value will be 0~300 NM
Coverage  ignored.
Frame The frame type of data in recording file
Type
Verify Turn on/off the filter of SAC/SIC. When selected, only plots with
SAC/SIC matching SAC/SIC are processed
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Parameter Description Constraint
Minimal Plots under this level will be ignored 0~420 FL
Level

Maximum  Plots above this level will be ignored 0~420 FL
Level

Level per  The levels between two coverage surfaces. Plots will be assigned to a 0~100 FL

Layer layer closest to its actual level

Feed Dir Directory to read radar plots recording files. All files under this
directory with “.rex” suffix will be processed.

If any field contains an error, a warning message will be displayed.

@ Radar Coverage Analyze - ASTERIX Protocol Analyzer

Badar Analyre
Hame |[Demo Radar I:l Ver:1fy SAC/SIC
SAC/SIC |255 = |25 = Minimal Level (FL) [O =

Maximum Level (FL) (400

1k

Format CATO05/034/045 -

UAF | Automatic - Level per Layer (FL) (95

1k

4k

Maximum Coverage (HM) (250

Frame Tyvpe Hone -

Feed Dir |c:  ASTOATA coverage/feed

IAX ILEVEL AHD LATER MISMATCH )4

Cancal

Figure 7.4: Warnings in Radar Coverage Config Window
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8 Radar North Marker & Sector Missing Analyze

8.1 Overview

The radar north marker and sector message missing analyze tool is used to detect any missing north
marker message and sector message received from a specific radar.

For north marker message, system will calculate time interval of two north marker messages. If the
interval is greater than radar rotation period plus a tolerance value, system will assume one north
marker message is missing, and a warning message will be printed.

For sector message, system will check if the sector number in a sequence of messages is continue. If
not, system will assume one or more sector messages are missing, and warning message(s) will be
printed.

8.2 Preparation

To make a correct analyze on north marker and sector messages, it requires:

+ Avalid time is included in north marker message
+ Avalid sector is included in sector message

It means, the following dataitems must be included in received ASTERIX message.
Category 002

+ 1002/000 - Message Type
+ 1002/030 - Time of Day
« 1002/020 - Sector Number

Category 034

+ 1034/000 - Message Type
« 1034/030 - Time of Day
+ 1034/020 - Sector Number
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8.3 User Interface

The main window of radar north marker & sector missing analyze tool is as below.

(%) Radar North Marker & Sector Analyze - ASTERIX Protocol Analyzer - O x

File Analyze Help

HO0O0 & 00

Save  Start Stop | Settings Help  Close

Figure 8.1: Main Window

Before starting analyze, it’s necessary to open the configuration window by clicking on Settings but-
ton.
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@ Radar Morth Marker & Sector Analyze - ASTERIX Protocol Analyzer g
Radar Analyze
sac/sic o |[o | [] Verify SAC/SIC
Rotation Period (sec) Morth Mark Missing
Sector Mumber |32 - Delay Tolarance (%) IEI

UAP | Automatic Sector Missing

Frame Type Mone 7

Recording File |C:fASTDatafsamplefradar.rex |

Cancel

Figure 8.2: Settings Window

The meaning of each parameter is listed below.

Parameter Description

SAC/SIC SAC and SIC of radar

Rotation ~ Radar antenna rotation period

Period

Sector Number of sectors a radar will report in one antenna rotation
Number

UAP UAP of radar data

Frame Frame type of radar data

Type

Verify If selected, only data match SAC and SIC will be processed. If not selected, all data
SAC/SIC will be processed.

North If selected, system will analyze radar north marker message missing
Marker

Missing
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Parameter Description

Delay Tolerance on north marker message delay, in a north marker is received more than
Tolerance antenna rotation period + tolerance, system will assume one north marker message
is missing in the middle

Sector If selected, system will analyze sector message missing
Missing

Recording Recording file for analyze, support rex and rei file
File

When all parameters are set, analyze can be started by clicking on Start button; and process can be
interrupted by clicking on Stop button.

During the process, if any north marker or sector message missing is detected, a log message will be
printed.

When analyze finish, statistic information will be printed.
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(%) Radar Morth Marker & Sector Analyze - ASTERIX Protocol Analyzer - O X

File Analyze Help

HO0O0 & o8

Save  Start Stop | Settings Help Close

Analysis start. ~
[5CM] Sector cross missing detected at 05:00:00,734
[SCM] Previous: 12 Current: 15 Missing: 2
[5CM] Sector cross missing detected at 05:21:44.523
[5CM] Previous:30 Current:0 Missing: 1
[SCM] Sector cross missing detected at 05:33:45.335
[5CM] Previous: 20 Current:22 Missing: 1
[5CM] Sector cross missing detected at 05:35:38,367
[5CM] Previous: 15 Current: 17 Missing: 1
[5CM] Sector cross missing detected at 05:36:17. 101
[5CM] Previous: 10 Current: 12 Missing: 1
[5CM] Sector cross missing detected at 05:38:23.757
[5CM] Previous: 29 Current:31 Missing: 1
[SCM] Sector cross missing detected at 05:40:25,437
[5CM] Previous: 16 Current: 18 Missing: 1
[5CM] Sector cross missing detected at 05:40:42,437
[5CM] Previous: 30 Current:0 Missing: 1
[5CM] Sector cross missing detected at 05:44:28.953
[5CM] Previous: 23 Current:25 Missing: 1
[5CM] Sector cross missing detected at 05:44:33.914
[5CM] Previous: 23 Current:25 Missing: 1
[SCM] Sector cross missing detected at 05:46:55.812
[5CM] Previous: 13 Current: 15 Missing: 1
[5CM] Sector cross missing detected at 05:54:46,304
[SCM] Previous: 16 Current; 18 Missing: 1
Analysis finish.

Statistics:
Data processed from 2016-01-26T05:00:00 to 2016-01-26T05:59:59
Data duration 1.00 hours

Data Packets

Total: 155709

Good: 155706

Bad: 3

Rate: 31141 packets/second
Data Blocks

Total: 155706

CATOO1: [¥]

CATOOZ2: 4]

CATODS: 310

CATO34: 24000

CATO43: 1313586

Other: 0

Rate: 31141 blocksfsecond

Data Records

Total: 155706

CATOO1: [¥]

CATOOZ2: 4]

CATODS: 310

CATO34: 24000

CATO43: 1313586

Other: 0

Rate: 31141 recordssecond
Merth Mark Missing

[MMM] Morth mark missing: 0

Sector Missing
[SCM] Sector missing: 12 ]

Figure 8.3: Process Log
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9 Message Transmission Delay Analyze

9.1 Overview

The message transmission delay analyze tool is used to calculate delay time during transmission from
surveillance sensor to receiver.

System will compare the timestamp encoded in ASTERIX message, which is the sensor transmission
time (Tx), and the timestamp encoded in data packet, which is the receiving time (Rx). The difference
between Rx and Tx is considered as transmission delay.

When the calculated is greater than a warning level, a message will be shown in log.

When the calculated is greater than a discard level, or is less than zero, it will not be used for further
statistic, and a message will be shown in log.

9.2 Preparation

To generate a correct delay time, it requires:

« Avalid Rx timeis included in data packet

« Avalid Txtime isincluded in ASTERIX data

« Both Rx and Tx time must be UTC time, or in a same time zone

« Both Rx and Tx clock must be synchronized with a common time source, normally GPS

The timestamp in the following dataitems will be used as Tx time:

+ 1002/030 - Time of Day
+ 1034/030 - Time of Day

9.3 User Interface

The main window of message transmission delay analyze tool is as below.
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@ Message Transmission Delay Analyze - ASTERIX Protocol Analyzer - O X

File Analyze Help

HOO e ©8

Save  Start Stop  Settings Help Close

Log Chart

Figure 9.1: Main Window

Before starting analyze, it’s necessary to open the configuration window by clicking on Settings but-
ton.
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@ Meszage Transmission Delay &nalyze - ASTERIX Protocal Analyzer X

Sensor Analyze

SAC/SIC o] [] Verify SAC/SIC
UAP | Auto ™ Warning threadhold (msec)

Frame Type |Mone - Maximum allowed delay (msec) | 10000

Recording File

Transmission Delay is avaliable for packets with valid receiving timestamp.

It wil compare receiving timestamp in packet and transmission timestamp in message to calculate
transmission delay.

If the calculated delay is more than maximum allowed delay, the packet will be ignored.

Cancel

Figure 9.2: Settings Window

The meaning of each parameter is listed below.

Parameter Description

SAC/SIC SAC and SIC of sensor

UAP UAP of sensor data

Frame Type Frame of sensor data

Verify SAC/SIC If selected, only data match SAC and SIC will be processed. If not
selected, all data will be processed.

Warning thread hold If calculated delay is greater than this value, a log message will be
printed

Maximum allowed If calculated delay is greater than this value, a log message will be

delay printed, and this delay will not be used in statistic

Recording File Recording file for analyze, support rex and rei file

When all parameters are set, analyze can be started by clicking on Start button; and process can be
interrupted by clicking on Stop button.
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During the process, if any message match the warning or discard threshold, a log message will be
printed.
When analyze finish, statistic information will be printed, and a delay chart will be shown in the Chart

table.
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G) Message Transmission Delay Analyze - ASTERIX Protocol Analyzer

HOoO ¢ @R
Save Start Stop  Settings Help Close

Log Chart

VEITY SAL/SICT TN

Frame Type: None

UAP: Auto

Delay Warning: 400 msec
Max Delay Allowed: 500 msec

Analysis start.

Delay discard: Tx Tue Jan 26 04:59:59 2016 Rx Tue Jan 26 05:00:00 2016 Delay 1023 msec
Delay discard: Tx Tue Jan 26 04:59:59 2016 Rx Tue Jan 26 05:00:00 2016 Delay 867 msec
Delay discard: Tx Tue Jan 26 05:00:00 2016 Rx Tue Jan 26 05:00:00 2016 Delay 718 msec
Delay discard: Tx Tue Jan 26 05:00:00 2016 Rx Tue Jan 26 05:00:00 2016 Delay 562 msec
Delay warning: Tx 05:55:20.898 Rx 05:55:21, 316 Delay 418 msec

Delay warning: Tx 05:55:30.804 Rx 05:55:31. 263 Delay 459 msec

Delay warning: Tx 05:55:40.726 Rx 05:55:41, 167 Delay 441 msec

Delay warning: Tx 05:55:50,593 Rx 05:55:51.043 Delay 450 msec

Delay warning: Tx 05:56:00.500 Rx 05;56:00,952 Delay 458 msec

Delay warning: Tx 05:56:10.421 Rx 05:56: 10,858 Delay 437 msec

Delay warning: Tx 05:56:20. 296 Rx 05:56:20, 739 Delay 443 msec

Delay warning: Tx 05:56:30. 187 Rx 05:56:30.637 Delay 450 msec

Delay warning: Tx 05:56:40, 101 Rx 05:56:40, 528 Delay 427 msec

Delay warning: Tx 05:57:09. 781 Rx 05:57: 10,224 Delay 443 msec

Analysis finish,

Statistics:
Data processed from 2016-01-26T05:00:00 to 2016-01-26T05:59:59
Data duration 1.00 hours

Data Packets

Total: 155709

Good: 155706

Bad: 3

Rate: 38927 packets/second

Data Blocks

Total: 155706

CATOO1: 4]

CATODZ: [¥]

CATOOS: 310

CATO34: 24000

CATO43: 1313586

Other: 0

Rate; 38926 blocks fzecond

Data Records

Total: 155706

CATOO1: o]

CATODZ: 4]

CATOOS: 310

CATO34: 24000

CATO4E: 131396

Other: 0

Rate: 38926 records second

Transmission Delay

Message sampled: 23996
Message warning: 10
Minimum Delay: 18 msec
Maximum Delay: 459 msec
Average Delay: 145,38 msec

Figure 9.3: Process Log
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Message Tranmission Delay

459

Delay (ms)
B

114

05:53:19 05:59:59

05:33:20 05:40:00 05:45:40
Time

0
05:00:00 05:06:40 05:13:20 05:20:00 05:26:40

Figure 9.4: Delay Chart
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10 Appendix

10.1 Change Log

10.1.1 Version1
10.1.1.1 Version 1.24.0 Release 2022-12-23

« Support ASTERIX CATO015;

» Support ASTERIX CATO16;

« New column “Timestamp Rx” in list view;

+ New column “Range” in list view;

« New column “Azimuth” in list view;

+ New column “Doppler Velocity” in list view;
« Simple filter support “category”;

+ Ulimprovement on Windows high DPI display;
« Support Windows 11,

« Update user manual,

+ Bugfix.

10.1.1.2 Version 1.23.0 Release 2021-11-25

New tool “Coordinate Calculator”;
« New column “Selected Altitude” in list view;

KML output improves coordinate accuracy;

Can specify WGS-84 coordinate format in settings;
+ Bug fix.

10.1.1.3 Version 1.22.0 Release 2021-10-21

+ New column “Velocity” and “Vertical Rate” in list view;
« New filter function;
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+ Support new Indra file format (OEM);
+ Bug fix.

10.1.1.4 Version 1.21.0 Release 2021-03-22

Remove WebKit dependency;

Support Wisesoft frame type;

Bug fix: crash when receiving data from UDP;
+ Bug fix: stop when receiving data from UDP.

10.1.1.5 Version 1.20.0 Release 2020-12-25

« Support ASTERIX CAT021 v2.4;
« New recent files feature;
+ KML export supports CAT021 data with valid track number.

10.1.1.6 Version 1.19.0 Release 2020-10-08

« Support ASTERIX CAT065;
+ Update OEM functions.

10.1.1.7 Version 1.18.0 Release 2020-07-19

« New capture window to receive live data from UDP multicast/broadcast/unicast;

File converter support REB file;
« Use offline help contents first;
Update U,

Update OEM functions.

10.1.1.8 Version 1.17.0 Release 2020-06-12

« Rename to “Sky Analyzer for ASTERIX”;
» Support ASTERIX CAT004;
+ Update OEM functions.
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10.1.1.9 Version 1.16.2 Release 2020-04-10

« Update external interfaces;
+ Bug fix: Introduce extra checking for UDP frame;
« Update copyright info.

10.1.1.10 Version 1.16.1 Release 2020-02-29

REB format updated to version 2;

Remove supports to REB format version 1;

Support Google China Map;
» Remove supports to Open Street Map;

Fix bugs.

10.1.1.11 Version 1.16.0 Release 2019-05-24

Support ASTERIX CAT010 v1.10;
Support ASTERIX CAT062 v1.16;
Update depending libraries;

Update copyright info;
Fix bugin BDS5,0.

10.1.1.12 Version 1.15.0 Release 2018-07-11

 Launch external tools from menu and toolbar;
+ Support new binary recording format;
+ Fix bugin WGS-84 decoding.

10.1.1.13 Version 1.14.1 Release 2018-05-08

+ Update depending libraries.

10.1.1.14 Version 1.14.0 Release 2018-04-18

« Support ASTERIX CAT240;
« New Settings window to configure hex and bin display;
+ Improve tcpdump *.pcap file compatibility.

SinoATC Ltd.
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10.1.1.15 Version 1.13.0 Release 2018-01-07

« Support filter by ICAO address.

10.1.1.16 Version 1.12.0 Release 2017-12-14

« Support *.bin raw ASTERIX data file format;
+ Bug fix: CAT021 Thales UAP.

10.1.1.17 Version 1.11.0 Release 2017-11-17

« Supports up to 64 datarecords in one datablock;

Improved OEM support;
Bug fix: 1020/400 decode error;
Bug fix: WGS-84 coordinate decode error.

10.1.1.18 Version 1.10.3 Release 2017-10-21

+ Bug fix: SSR code in simple filter is not working.

10.1.1.19 Version 1.10.2 Release 2017-05-05

« Update user manual;
« File converter supports DataRP v1 format;
+ Bug fix.

10.1.1.20 Version 1.10.1 Release 2017-04-08

« Alternative service provider for embedded map;
« Different color theme for detail display;
+ User manual for radar coverage analyze.

10.1.1.21 Version 1.10.0 Release 2017-01-09

+ New radar coverage analyze tool;
+ Sensor status analyze has been separated into two parts;

SinoATC Ltd.
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« Support more property file formats;

+ Bug Fix: No response when reading .ast file.

10.1.1.22 Version 1.9.0 Release 2016-12-11

PDF export;

64-bit support on Windows;

Windows XP not supported any more;

CATO021 support encoding;
+ Bug Fix.

10.1.1.23 Version 1.8.2 Release 2016-09-21

+ Bug Fix: Can’t stop reading multicast data.

10.1.1.24 Version 1.8.1 Release 2016-09-01

« Bug Fix: CAT021 v0.23 UAP error;
+ Bug Fix: XML recording file extension error.

10.1.1.25 Version 1.8.0 Release 2016-06-25
« Support multiple datablocks in one packet;

« CATO001 support list view;
+ Bug Fix.

10.1.1.26 Version 1.7.2 Release 2016-05-04

+ Display sensor info by using libairdb;
+ Bug Fix.

10.1.1.27 Version 1.7.1 Release 2016-04-04

« Support CAT021 version 2.x;

+ Bug Fix: Track view polar coordination display;
+ Bug Fix: File type match error for files with multiple suffix.

SinoATC Ltd.
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10.1.1.28 Version 1.7.0 Release 2016-02-23

Lua script filter;
* New Ul;
Load sample data;

Bug Fix: Crash when loading data file from index file.

10.1.1.29 Version 1.6.2 Release 2016-01-29

+ Bug Fix: SSA NMM doesn’t work and always report 0 north mark missing.

10.1.1.30 Version 1.6.1 Release 2016-01-27

+ SSANMM/SCM/TMD now works with CAT034;
+ Improve performance when load large number (1 million and more) of packets;
+ Improve performance of filter.

10.1.1.31 Version 1.6.0 Release 2016-01-26

+ New SSA configuration window;
« SSA transmission delay (TMD) statistic function;

10.1.1.32 Version 1.5.0 Release 2016-01-09

« RDCUViewer function;
« RDCUExtractor function;
+ Feature show/hide according to license file;

10.1.1.33 Version 1.4.0 Release 2015-12-23

Filter out unmatch datarecords in one datablock;

Export data to Google Earth;

Export data to C struct;
« Site status analysis tool;

File format conversion tool;

Install license function;

SinoATC Ltd.
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10.1.1.34 Version 1.3.0 Release 2015-11-08

+ Display country name/flag when Mode-S address is available;

« New frame type: iCON and UDP+iCON.

10.1.1.35 Version 1.2.3 Release 2015-09-22

+ Fix crash on clicking data packet while filtering.

10.1.1.36 Version 1.2.2 Release 2015-09-18

+ Improve filter performance;
« Display filter progress.

10.1.1.37 Version 1.2.1 Release 2015-08-12

+ Support keyword “Mode-C”.

10.1.1.38 Version 1.2.0 Release 2015-03-31

« Auto UAP selection.

10.1.1.39 Version 1.1.0 Release 2015-03-27

« Support SIATM output format;
« Button to launch DataPlayback tool;
« Tool launch problem under Linux.

10.1.1.40 Version 1.0.0 Release 2015-01-19

+ Adapt to liblicense;
« New Ul icons.

SinoATC Ltd.
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10.1.2 Version 0
10.1.2.1 Version 0.9.0 Release 2014-12-16

« Adapt to libasterix 0.8.0;
+ Adapt to libastfile 0.1.0;
« Adapt to liblicense.

10.1.2.2 Version 0.8.0 Release 2014-11-03

+ Support VisualAST recording file format.

10.1.2.3 Version 0.7.0 Release 2014-10-07

+ Improved Ul;

« Live multicast input;
 Export list to CSV file;

+ Export data to XML file;
« External tools;

+ Register info collection.

10.1.2.4 Version 0.6.0 Release 2014-10-05

« New list view.

10.1.2.5 Version 0.5.1 Release 2014-09-26

« Show datarecord html detail.

10.1.2.6 Version 0.5.0 Release 2014-08-28

+ Support AirNet recording file format;
+ Show runtime info in about window.

10.1.2.7 Version 0.4.2 Release 2014-07-15

« Adapt to libasterix 0.7.0;
« New UAP for CAT001 plot.

SinoATC Ltd.
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10.1.2.8 Version 0.4.1 Release 2014-06-29

« Adapt to new glincense lib.

10.1.2.9 Version 0.4.0 Release 2014-06-24

« Support RDCU recording file format;
+ Increase file loading speed;

« Use standard Windows localtion for file access.

10.1.2.10 Version 0.3.0 Release 2014-03-09

« Filter function;

« Data frame type auto selection function.

10.1.2.11 Version 0.2.1 Release 2013-10-31

+ Data frame type selection function.

10.1.2.12 Version 0.2.0 Release 2013-08-08

+ Support tcpdump/Wireshark file format.

10.1.2.13 Version 0.1.2 Release 2013-08-07

« Adapt to libasterix 0.5.2;
« UAP selection function.

10.1.2.14 Version 0.1.1 Release 2013-07-25

« Adapt to libasterix 0.4.0;

« Printand “save as HTML” function for dataitem detail.

10.1.2.15 Version 0.1.0 Release 2013-07-21

+ New look and feel in dataitem detail display.

SinoATC Ltd.
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10.1.2.16 Version 0.0.3 Release 2013-07-19

+ Adapt to new libasterix headers.

10.1.2.17 Version 0.0.2 Release 2013-07-17

+ Use WebKit to display dataitem details.

10.1.2.18 Version 0.0.1 Release 2013-07-10

« Initial release.
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